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3. Debugging Nios II Designs
This chapter describes best practices for debugging Nios® II processor software 
designs. Debugging these designs involves debugging both hardware and software, 
which requires familiarity with multiple disciplines. Successful debugging requires 
expertise in board layout, FPGA configuration, and Nios II software tools and 
application software. This chapter includes the following sections that discuss 
debugging techniques and tools to address difficult embedded design problems:

■ “Debuggers”

■ “Run-Time Analysis Debug Techniques” on page 3–11

Debuggers
The Nios II development environments offer several tools for debugging Nios II 
software systems. This section describes the debugging capabilities available in the 
following development environments:

■ “Nios II Software Development Tools”

■ “FS2 Console” on page 3–9

■ “SignalTap II Embedded Logic Analyzer” on page 3–10

■ “Lauterbach Trace32 Debugger and PowerTrace Hardware” on page 3–10

■ “Insight and Data Display Debuggers” on page 3–10

Nios II Software Development Tools
The Nios II Integrated Development Environment (IDE) is a graphical user interface 
(GUI) that supports creating, modifying, building, running, and debugging Nios II 
programs. The Nios II software build tools are command-line utilities available from a 
Nios II command shell. Using the software build tools provides fine control over the 
build process and project settings, but also requires more expertise than does using 
the Nios II IDE.

SOPC Builder is a system development tool for creating systems including processors, 
peripherals, and memories. The tool enables you to define and generate a complete 
FPGA system very efficiently. SOPC Builder does not require that your system contain 
a Nios II processor. However, it provides complete support for integrating Nios II 
processors in your system, including some critical debugging features.

The following sections describe debugging tools and support features available in the 
Nios II software development tools:

■ “Nios II System ID”

■ “Project Templates” on page 3–2

■ “Configuration Options” on page 3–3

■ “Nios II GDB Console and GDB Commands” on page 3–5

■ “Nios II Terminal Window and stdio Library Functions” on page 3–6
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■ “Importing Projects Created Using the Nios II Software Build Tools” on page 3–7

■ “Selecting a Processor Instance in a Multiple Processor Design” on page 3–7

Nios II System ID
The system ID feature is available as a system component in SOPC Builder. The 
component allows the debugger to identify attempts to download software projects 
with system libraries that were generated for a different SOPC Builder system. This 
feature protects you from inadvertently using an executable and loadable format (.elf) 
file built for a Nios II hardware design that is not currently loaded in the FPGA. If 
your application image does not run on the hardware implementation for which it 
was compiled, the results are unpredictable.

To start your design with this basic safety net, always select Validate Nios II system 
ID before software download on the Main tab of the Nios II IDE Debug dialog box, 
as shown in Figure 3–4 on page 3–8.

The system ID feature requires that the SOPC Builder design include a system ID 
component. Figure 3–1 shows an SOPC Builder system with a system ID component.

f For more information about the System ID component, refer to the System ID Core 
chapter in volume 5 of the Quartus II Handbook.

Project Templates
The Nios II IDE helps you to create a simple, small, and pretested software project to 
test a new board.

Figure 3–1. SOPC Builder System With System ID Component
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The Nios II IDE provides a mechanism to create new software projects using project 
templates. To create a new project for which you already have source code, perform 
the following steps:

1. In the Nios II C/C++ perspective, on the File menu, on the New submenu, click 
Nios II C/C++ Application. 

The New Project wizard for Nios II C/C++ application projects appears, 
pre-selecting the current SOPC Builder system .ptf file.

2. Click Next. 

3. In the Select Project Template list, click Blank Project.

4. If your project contains multiple Nios II processors, in the CPU list, click the CPU 
you wish to run this application software.

5. Click Finish.

6. On the Nios II IDE C/C++ Projects page, copy your source code files to the new 
project by dragging them onto the newly created project label.

To create a simple test program to test a new board, perform these steps with the 
following exceptions:

■ In step 3, click Hello World Small

■ Do not perform step 6. 

The Hello World Small template is a very simple, small application. Using a simple, 
small application minimizes the number of potential failures that can occur as you 
bring up a new piece of hardware.

Configuration Options
The following Nios II IDE configuration options increase the amount of debugging 
information available for your application image .elf file:

■ Objdump File

■ Show Make Commands

■ Show Line Numbers

Objdump File

You can direct the Nios II build process to generate helpful information about your 
.elf file in an object dump text file (.objdump). The .objdump file contains 
information about the memory sections and their layout, the addresses of functions, 
and the original C source code interleaved with the assembly code. Example 3–1 
shows part of the C and assembly code section of an .objdump file for the Nios II 
built-in Hello World Small project.
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To enable this option in the Nios II IDE, perform the following steps:

1. On the Window menu, click Preferences. 

2. On the list to the left, click Nios II.

3. On the Nios II page, turn on Generate objdump file.

After the next build, the .objdump file is found in the same directory as the 
newly built .elf file.

After the next build generates the .elf file, the build runs the nios2-elf-objdump 
command with the options --disassemble-all, --source, and --all-headers 
on the generated .elf file. 

In the Nios II user-managed tool flow, you can edit the settings in the application 
makefile that determine the options with which the nios2-elf-objdump command 
runs. Running the create-this-app script, or the nios2-app-generate-makefile script, 
creates the following lines in the application makefile:

#Options to control objdump.
CREATE_OBJDUMP := 1
OBJDUMP_INCLUDE_SOURCE :=0
OBJDUMP_FULL_CONTENTS := 0

Example 3–1. Piece of Code in .objdump File From Hello World Small Project

06000170 <main>:

include "sys/alt_stdio.h"

int main()
{ 
6000170:deffff04 addisp,sp,-4
alt_putstr("Hello from Nios II!\n");
6000174:01018034 movhir4,1536
6000178:2102ba04 addir4,r4,2792
600017c:dfc00015 stwra,0(sp)
6000180:60001c00 call60001c0 <alt_putstr>
6000184:003fff06 br6000184 <main+0x14>

06000188 <alt_main>:
* the users application, i.e. main().
*/

void alt_main (void)
{
6000188:deffff04 addisp,sp,-4
600018c:dfc00015 stwra,0(sp)

static ALT_INLINE void ALT_ALWAYS_INLINE 
alt_irq_init (const void* base)
{
NIOS2_WRITE_IENABLE (0);
6000190:000170fa wrctlienable,zero
NIOS2_WRITE_STATUS (NIOS2_STATUS_PIE_MSK);
6000194:00800044 movir2,1
6000198:1001703a wrctlstatus,r2
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Edit these options to control the .objdump file according to your preferences for the 
project:

■ CREATE_OBJDUMP—The value 1 directs nios2-elf-objdump to run with the 
options --disassemble, --syms, --all-header, and --source.

■ OBJDUMP_INCLUDE_SOURCE—The value 1 adds the option --source to the 
nios2-elf-objdump command line.

■ OBJDUMP_FULL_CONTENTS—The value 1 adds the option --full-contents to 
the nios2-elf-objdump command line.

1 For detailed information about the information each command-line option generates, 
in a Nios II command shell, type the following command:
nios2-elf-objdump --help r

Show Make Commands

To enable a verbose mode for the make command in the Nios II IDE, perform the 
following steps:

1. On the Window menu, click Preferences. 

2. On the list to the left, click Nios II. 

3. On the Nios II page, turn on Show command lines when running 'make' (i.e. 
Don't use '-s' flag on make).

Show Line Numbers

To enable display of C source-code line numbers in the Nios II IDE, follow these steps:

1. On the Window menu, click Preferences. 

2. On the list to the left, under General, under Editors, select Text Editors.

3. On the Text Editors page, turn on Show line numbers.

Nios II GDB Console and GDB Commands
The Nios II GDB console allows you to send GDB commands to the Nios II processor 
directly. 

First, enable the GDB console on the Debugger tab of the Debug dialog box, by 
turning on Verbose console mode. This mode displays all of the GDB commands that 
are sent to and received by the Nios II processor on the GDB console. 

To display this console, which allows you to view these commands and to enter your 
own GDB commands, click the blue monitor icon on the lower right corner of the 
Nios II Debug perspective. If multiple consoles are connected, click the black arrow 
next to the blue monitor icon to list the available consoles. On the list, select the Nios 
II GDB console. Figure 3–2 shows the console list icon—the blue monitor icon and 
black arrow—that allow you to display the GDB console.
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An example of a useful command you can enter in the Nios II GDB console is
dump binary memory <file> <start_addr> <end_addr> r

This command dumps the contents of a specified address range in memory to a file on 
the host computer. The file type is binary. You can view the generated binary file using 
the HexEdit hexadecimal-format editor that is available from 
www.expertcomsoft.com.

Nios II Terminal Window and stdio Library Functions
If the Nios II processor outputs characters using the stdio library functions, but no 
terminal session exists to receive these characters, the Nios II software system 
deadlocks. If you use the alt_log() function, rather than the printf() function, to 
transmit characters to a nios2-terminal session or to the Nios II IDE terminal window, 
the system does not deadlock if no terminal session is available to receive the 
transmitted characters.

If neither of the consoles is connected, the output buffer fills. Then the system hangs 
on the next stdio library function write. If you select the Reduced Device Drivers 
option on the System Properties page in SOPC Builder, stdout uses the 
polling-mode device driver. This driver polls in a loop, waiting for the character 
output buffer to empty before the driver can transmit more characters. If no real-time 
operating system is running, and the E_WOULD_BLOCK ioctl() control code is 
not sent to the UART driver for the Nios II terminal, the Nios II software system 
hangs waiting to transmit characters as the result of a printf() statement in 
application code.

Figure 3–2. Console List Icon

Console
list
icon
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f For more information about the alt_log() function, refer to AN459: Guidelines for 
Developing a Nios II HAL Device Driver.

Importing Projects Created Using the Nios II Software Build Tools
Whether a project is created and built using the Nios II software build tools or using 
the Nios II IDE, you can debug the resulting .elf image file in the Nios II IDE. 

f For information about how to import a project created with the Nios II software build 
tools to the Nios II IDE, refer to the "Getting Started" section in the Introduction to the 
Nios II Software Build Tools chapter of the Nios II Software Developer's Handbook.

Selecting a Processor Instance in a Multiple Processor Design
In a design with multiple Nios II processors, you must create a different software 
project for each processor. When you create the application project, the Nios II IDE 
generates a system library. For system library generation, you must specify the CPU 
to which the application project is targeted.

Figure 3–3 shows how you specify the CPU for the application in the Nios II IDE. The 
Nios II C/C++ Application page of the New Project wizard collects the information 
required for system library creation. This page derives the list of available CPU 
choices from the .ptf for the system.

Figure 3–3. Nios II IDE Nios II C/C++ Application Page — CPU Selection
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In the Main tab of the Debug dialog box, shown in Figure 3–4, click the Load JDI File 
button to select the JTAG debug interface (.jdi) file for your SOPC Builder project. The 
.jdi file is typically located in the same directory as the SRAM object file (.sof) for the 
project. The .jdi file is parsed and its contents compared to the name of the CPU you 
select for the current project, to determine the correct instance ID number. The 
command-line option --instance = <instance ID> is appended to the implicit 
debug command that the Nios II IDE runs. The text for the command-line option 
appears in the Additional nios2-download arguments field next to the Load JDI File 
button. Clicking this button ensures that the proper instance ID is used for the 
selected CPU, whether or not the Quartus II software modified the instance IDs.

From the Nios II command shell, the jtagconfig –n command identifies available 
JTAG devices and the number of CPUs in the subsystem connected to each JTAG 
device. Example 3–2 shows the system response to a jtagconfig -n command.

Figure 3–4. Nios II IDE Debug Configuration Page — Load JDI File Button

Load
JDI file
button

Example 3–2. Two-FPGA System Response to jtagconfig Command

[SOPC Builder]$ jtagconfig -n
1) USB-Blaster [USB-0]
120930DD EP2S60
Node 11104600
Node 0C006E00

2) USB-Blaster [USB-1]
020B40DD EP2C35
Node 11104601
Node 11104602
Node 11104600
Node 0C006E00
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The response in Example 3–2 lists two different FPGAs, connected to the running 
JTAG server through different USB-Blaster™ cables. The cable attached to the USB-0 
port is connected to a JTAG node in an SOPC Builder subsystem with a single Nios II 
core. The cable attached to the USB-1 port is connected to a JTAG node in an SOPC 
Builder subsystem with three Nios II cores. The node numbers represent JTAG nodes 
inside the FPGA. The appearance of the node number 0x111046xx in the response 
confirms that your FPGA implementation has a Nios II processor with a JTAG debug 
module. The appearance of a node number 0x0C006Exx in the response confirms 
that the FPGA implementation has a JTAG UART component. The CPU instances are 
identified by the least significant byte of the Nodes beginning with 111. The JTAG 
UART instances are identified by the least significant byte of the Nodes beginning 
with 0C. Instance IDs begin with 0.

Only the CPUs that have JTAG debug modules appear in the listing. Use this listing to 
confirm you have created JTAG debug modules for the Nios II processors you 
intended.

FS2 Console
On Windows platforms, you can use a Nios II-compatible version of the First Silicon 
Solutions, Inc. (FS2) console. The FS2 console is very helpful for low-level system 
debug, especially when bringing up a system or a new board. It provides a TCL-based 
scripting environment and many features for testing your system, from low-level 
register and memory access to debugging your software (trace, breakpoints, and 
single-stepping).

To run the FS2 console in the Nios II IDE, on the Debugger tab of the Debug dialog 
box, turn on Use FS2 console window for trace and watchpoint support. To run the 
FS2 console using the software build tools, use the nios2-console command.

f For more details about the Nios II-compatible version of the FS2 console, refer to the 
FS2-provided documentation in your Nios II installation, at 
$SOPC_KIT_NIOS2\bin\fs2\doc.

In the FS2 console, the sld info command returns information about the JTAG nodes 
connected to the system-level debug (SLD) hubs—one SLD hub per FPGA—in your 
system. If you receive a failure response, refer to the FS2-provided documentation for 
more information.

Use the sld info command to verify your system configuration. After communication 
is established, you can perform simple memory reads and writes to verify basic 
system functionality. The FS2 console can write bytes or words, if Avalon® 
Memory-Mapped (Avalon-MM) interface byteenable signals are present. In 
contrast, the Nios II IDE memory window can perform only 32-bit reads and writes 
regardless of the 8- or 16-bit width settings for the values retrieved. If you encounter 
any issues, you can perform these reads and writes and capture SignalTap® II 
embedded logic analyzer traces of related hardware signals to diagnose a hardware 
level problem in the memory access paths.
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SignalTap II Embedded Logic Analyzer
The SignalTap II embedded logic analyzer can help you to catch some 
software-related problems, such as an interrupt service routine that does not properly 
clear the interrupt signal. 

f For information about the SignalTap II embedded logic analyzer, refer to the Design 
Debugging Using the SignalTap II Embedded Logic Analyzer chapter in volume 3 of the 
Quartus II Handbook and AN323: Using SignalTap II Embedded Logic Analyzers in SOPC 
Builder Systems, and the Verification and Board Bring-Up chapter of the Embedded Design 
Handbook.

The Nios II plug-in for the SignalTap II embedded logic analyzer enables you to 
capture a Nios II processor's program execution. 

f For more information about the Nios II plug-in for the SignalTap II embedded logic 
analyzer, refer to AN446: Debugging Nios II Systems with the SignalTap II Logic Analyzer. 

Lauterbach Trace32 Debugger and PowerTrace Hardware
Lauterbach Datentechnik GmBH (Lauterbach) (www.lauterbach.com) provides the 
Trace32 ICD-Debugger for the Nios II processor. The product contains both hardware 
and software. In addition to a connection for the 10-pin JTAG connector that is used 
for the Altera USB-Blaster cable, the PowerTrace hardware has a 38-pin mictor 
connection option.

Lauterbach also provides a module for off-chip trace capture and an instruction-set 
simulator for Nios II systems.

The order in which devices are powered up is critical. The Lauterbach PowerTrace 
hardware must always be powered when power to the FPGA hardware is applied or 
terminated. The Lauterbach PowerTrace hardware’s protection circuitry is enabled 
after the module is powered up.

f For more information about the Lauterbach PowerTrace hardware and the required 
power-up sequence, refer to AN543: Debugging Nios II Software Using the Lauterbach 
Debugger.

Insight and Data Display Debuggers
The Tcl/Tk-based Insight GDB GUI installs with the Altera-specific GNU GDB 
distribution that is part of the Nios II Embedded Design Suite (EDS). To launch the 
Insight debugger from the Nios II command shell, type the following command:
nios2-debug <file>.elf r

Although the Insight debugger has fewer features than the Nios II IDE, this debugger 
supports faster communication between host and target, and therefore provides a 
more responsive debugging experience.

Another alternative debugger is the Data Display Debugger (DDD). This debugger is 
compatible with GDB commands—it is a user interface to the GDB debugger—and 
can therefore be used to debug Nios II software designs. The DDD can display data 
structures as graphs.
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Run-Time Analysis Debug Techniques
This section discusses methods and tools available to analyze a running software 
system.

Software Profiling
Altera provides the following tools to profile the run-time behavior of your software 
system:

■ GNU profiler—The Nios II EDS toolchain includes the gprof utility for profiling 
your application. This method of profiling reports how long various functions run 
in your application.

■ High resolution timer—The SOPC Builder timer peripheral is a simple time 
counter that can determine the amount of time a given subroutine or code segment 
runs. You can read it at various points in the source code to calculate elapsed time 
between timer samples.

■ Performance counter peripheral—The SOPC Builder performance counter 
peripheral can profile several different sections of code with a series of counter 
peripherals. This peripheral includes a simple software API that enables you to 
print out the results of these timers through the Nios II processor's stdio services.

f For more information about how to profile your software application, refer to 
AN391: Profiling Nios II Systems.

f For additional information about the SOPC Builder timer peripheral, refer to the Timer 
Core chapter in volume 5 of the Quartus II Handbook, and to the Developing Nios II 
Software chapter of the Embedded Design Handbook.

f For additional information about the SOPC Builder performance counter peripheral, 
refer to the Performance Counter Core chapter in volume 5 of the Quartus II Handbook.

Watchpoints
Watchpoints provide a powerful method to capture all writes to a global variable that 
appears to be corrupted. The Nios II IDE supports watchpoints directly or through 
the FS2 console. Before you can set watchpoints in the Nios II IDE directly, you must 
make sure that, on the Debugger tab of the Debug dialog box, Use FS2 console 
window for trace and watchpoint support is turned off. 

For more information about watchpoints, refer to the Nios II online Help. In the 
Nios II IDE, on the Help menu, click Search. In the search field, type watchpoint, 
and select the topic Working with breakpoints and watchpoints.

To enable watchpoints, you must configure the Nios II processor’s debug level in 
SOPC Builder to debug level 2 or higher. To configure the Nios II processor’s debug 
level in SOPC Builder to the appropriate level, perform the following steps:

1. On the SOPC Builder System Contents tab, click the desired Nios II processor 
component. A list of options appears.

2. On the list, click Edit. The Nios II processor configuration page appears. 

3. Click the JTAG Debug Module tab, shown in Figure 3–5 on page 3–13. 
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4. Select Level 2, Level 3, or Level 4.

5. Click Finish.

Depending on the debug level you select, a maximum of four watchpoints, or data 
triggers, are available. Figure 3–5 on page 3–13 shows the number of data triggers 
available for each debug level. The higher your debug level, the more logic resources 
you use on the FPGA.

f For more information about the Nios II processor debug levels, refer to the 
Instantiating the Nios II Processor in SOPC Builder chapter of the Nios II Processor 
Reference Handbook.

Stack Overflow
You can enable the Nios II IDE to check for stack overflow. On the System Properties 
configuration page of your system library project, turn on Run time stack checking. 
Stack overflow is a common problem in embedded systems, because their limited 
memory requires that your application have a limited stack size. When your system 
runs a real-time operating system, each running task has its own stack, increasing the 
probability of a stack overflow condition. As an example of how this condition may 
occur, consider a recursive function, such as a function that calculates a factorial 
value. In a typical implementation of this function, factorial(n) is the result of 
multiplying the value n by another invocation of the factorial function, 
factorial(n-1). For large values of n, this recursive function causes many call 
stack frames to be stored on the stack, until it eventually overflows before calculating 
the final function return value.

Hardware Abstraction Layer (HAL)
The Altera HAL provides the interfaces and resources required by the device drivers 
for most SOPC Builder system peripherals. You can customize and debug these 
drivers for your own SOPC Builder system. To learn more about debugging HAL 
device drivers and SOPC Builder peripherals, refer to AN459: Guidelines for Developing 
a Nios II HAL Device Driver.

Breakpoints
You can set hardware breakpoints on code located in read-only memory such as flash 
memory. If you set a breakpoint in a read-only area of memory, a hardware 
breakpoint, rather than a software breakpoint, is selected automatically.

To enable hardware breakpoints, you must configure the Nios II processor’s debug 
level in SOPC Builder to debug level 2 or higher. To configure the Nios II processor’s 
debug level in SOPC Builder to the appropriate level, perform the following steps:

1. On the SOPC Builder System Contents tab, click the desired Nios II processor 
component. A list of options appears.

2. On the list, click Edit. The Nios II processor configuration page appears. 

3. Click the JTAG Debug Module tab, shown in Figure 3–5. 

4. Select Level 2, Level 3, or Level 4.

5. Click Finish.
Embedded Design Handbook © April 2009 Altera Corporation
Preliminary

http://www.altera.com/literature/hb/nios2/n2cpu_nii51004.pdf
http://www.altera.com/literature/an/an459.pdf
http://www.altera.com/literature/an/an459.pdf


Chapter 3: Debugging Nios II Designs 3–13
Run-Time Analysis Debug Techniques
Depending on the debug level you select, a maximum of four hardware breakpoints 
are available. Figure 3–5 shows the number of hardware breakpoints available for 
each debug level. The higher your debug level, the more logic resources you use on 
the FPGA. 

f For more information about the Nios II processor debug levels, refer to the 
Instantiating the Nios II Processor in SOPC Builder chapter of the Nios II Processor 
Reference Handbook.

Debugger Stepping and Using No Optimizations
Use the None (–O0) optimization level compiler switch to disable optimizations for 
debugging. Otherwise, the breakpoint and stepping behavior of your debugger may 
not match the source code you wrote. This behavior mismatch between code 
execution and high-level original source code may occur even when you click the 
i button to use the instruction stepping mode at the assembler instruction level. This 
mismatch occurs because optimization and in-lining by the compiler eliminated some 
of your original source code.

To set the None (–O0) optimization level compiler switch in the Nios II IDE, perform 
the following steps:

1. In the Nios II C/C++ perspective, right-click your application project. A list of 
options appears.

2. On the list, click Properties. 

3. In the left pane, click C/C++ Build. 

Figure 3–5. Nios II Processor — JTAG Debug Module — SOPC Builder Configuration Page
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4. Under Configuration Settings, click the Tool Settings tab.

5. On the list to the left, under Nios II Compiler, click General. 

6. In the Optimization Levels list, click None (-O0). 

To set this switch in the Nios II software build tools flow, modify the application 
makefile to assign APP_CFLAGS_OPTIMIZATION := -O0.

Conclusion
Successful debugging of Nios II designs requires expertise in board layout, FPGA 
configuration, and Nios II software tools and application software. Altera and 
third-party tools are available to help you debug your Nios II application. This 
chapter describes debugging techniques and tools to address difficult 
embedded design problems.
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Table 3–1 shows the revision history for this chapter.

Table 3–1. Document Revision History

Date and 
Document Version Changes Made Summary of Changes

April 2009
v1.2

■ Added reference to new application note 
AN543: Debugging Nios II Software Using the 
Lauterbach Debugger

■ Removed information made redundant by the 
new application note from “Lauterbach 
Trace32 Debugger and PowerTrace Hardware” 
section.

Removed information about 
the Lauterbach debugging 
tools now described in new 
application note.

June 2008
v1.1

Corrected Table of Contents —

March 2008
v1.0

Initial release. —
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